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YOKOGAWA Electric Corporation 

FA–M3 Series 

Computer Link Driver 
 Supported version TOP Design Studio V1.0 or higher  

 

CONTENTS 

We would like to thank our customers for using M2I's "Touch 

Operation Panel (M2I TOP) Series". Read this manual and familiarize 

yourself with the connection method and procedures of the “TOP and 

external device”. 

 

1. System configuration Page 2 

 

 

Describes the devices required for connection, the setting of 

each device, cables, and configurable systems. 

2. External device selection  Page 3 

 Select a TOP model and an external device. 

3. TOP communication setting Page 4 

 Describes how to set the TOP communication. 

4. External device setting Page 9 

 Describes how to set up communication for external devices. 

5. Cable table Page 12 

 Describes the cable specifications required for connection. 

6. Supported addresses 16 page 

 Refer to this section to check the addresses which can 

communicate with an external device. 
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1. System configuration 

The system configuration of TOP and “YOKOGAWA Electric Corporation – FA-M3 Series Computer Link” is as follows. 

 

Series CPU *Note 1) Link I/F 
Communication 

method 
System setting Cable 

FA–M3 

F3SP□□-□N 

F3SP□□-□H 

F3SP□□-□S 

Programmer Port 

on the CPU 
RS-232C 

3. TOP communication 

setting 

4.1. External device 

setting 1 

5.1. Cable table 1 

F3LC11-1F 

F3LC12-1F 

F3LC11-1N 

RS-232C 

3. TOP communication 

setting 

4.2. External device 

setting 2 

5.2. Cable table 2 

F3LC11-2N RS-422/485 

3. TOP communication 

setting 

4.2. External device 

setting 2 
5.3. Cable table 3 

F3LC11-2F RS-422/485 

3. TOP communication 

setting 

4.3 External device 

setting 3 

*Note 1) □ The number according to the model name is substituted for the symbol. 

 

 

■ Connection configuration 

 

ㆍ1:1 (one TOP and one external device) connection – configuration which is possible in RS232C/422 communication. 

 

 

ㆍ1:N (one TOP and multiple external devices) connection – configuration which is possible in RS422 communication. 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “YOKOGAWA Electric Corporation”. 

PLC Select an external device to connect to TOP. 
 

Model Interface Protocol 

FA-M3 Series Computer Link PC Link 
 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [ Project > Project properties > TOP settings] → [Project option > Check “Use HMI settings” > Edit > Serial ] 

– Set the TOP communication interface in TOP Design Studio. 

 

 

 
 

Items TOP External device Remarks 

Signal Level (port) 
RS-232C RS-422 RS-485 

RS-232C 

RS-422/485 
 

Baud Rate 19200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [ Project > Project properties > PLC setting > COM > “PLC1 : FA-M3 Series”] 

– Set the options of the communication driver of FA-M3 Series Computer Link in TOP Design Studio. 

 

 

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select the serial communication protocol between the TOP and an external device. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device and 

sending the next command request. 
 

Station Num Enter the prefix of an external device.  

Cpu No Enter the CPU no. of the external device.  
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3.2. Communication setting in TOP  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [ Main screen > Control panel > Serial ] 
 

 

Items TOP External device Remarks 

Signal Level (port) 
RS-232C RS-422 RS-485 

RS-232C 

RS-422/485 
 

Baud Rate 19200  

Data Bit 8  

Stop Bit 1  

Parity Bit None.  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device.  

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [ Main screen > Control panel > PLC ] 
 

  

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select the serial communication protocol between the TOP and an external device. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Station Num Enter the prefix of an external device.  

Cpu No Enter the CPU no. of the external device.  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [Control Panel > PLC ]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 
 

4.1 External device setting 1 (CPU-embedded Programmer Port) 
  

Set as below using “FA–M3 Series” Ladder Software “WideField3”.  

For more detailed setting method than that described in this example, refer to the PLC user manual. 

 

Step 1. Set as follows in [Project] – [Project Settings] – [Built-in Function Setup]. 

 

 

Items Settings Remarks 

Communication Mode Transmission Speed 19200bps  

 Data Bit 8 bit  

 Stop Bit 1 bit  

 Parity bit NONE  

Set up CPU Personal Personal Computer Link Function Check Fixed 

Computer Link Checksum Check Fixed 

 End Character Check Fixed 

 Protection Uncheck Fixed 

Step 2. Send the settings to CPU and resut the power. 
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4.2 External device setting 2 (F3LC11-1F, F3LC12-1F, F3LC11-1N/2N) 
 

Set up the Dip Switch located inside the side cover of the communication card to set up the communication.  

For more detailed setting method than that described in this example, refer to the PLC user manual. 
 

 
For detailed “Dip Switch” setting method, check the manual attached inside the side cover. 

 

Step 1. Station Number Switch setting 

Station Number Switch Settings Settings Remarks 

Station NO.  (x10) 0  
Station No.: 1  

Station NO.  (x 1) 1 

 

Step 2. Set the serial communication parameters as follows through the switch on the right side of the computer link module. 

① Transmission Speed Switch (SW1) setting 

Transmission Speed Switch Settings Settings Remarks 

Baudrate 6  19200 bps  

 

② Data Format Switch (SW2) setting 

Data Format Switch Contents Off ON Settings Remarks 

SW1 Character Length 7 bits 8 bits On  

SW2 
Parity 

None Yes Off  

SW3 Odd Even Off  

SW4 Stop bit 1 bit 2 bits Off  

SW5 Checksum None Yes On Fixed 

SW6 Ending Character None Yes On Fixed 

SW7 Protection feature None Yes Off Fixed 

SW8 *Note 1) Security feature None Yes Off Fixed 

 

Step 3. After completing the setting, reset the power. 

 

 

※ Precautions for 1:N network configuration 

When configuring 1:N network, only the card of the terminating station sets the Terminator Switch. If it is not the card of the 

terminating station, set it to “OFF”. 

“4-WIRE” for RS-422 configuration / “2-WIRE” for RS-485 configuration 
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4.3 External device setting 1 (F3LC11-2F) 
 

Set up the Dip Switch located inside the side cover of the communication card to set up the communication.  

For more detailed setting method than that described in this example, refer to the PLC user manual. 
 

 
For detailed “Dip Switch” setting method, check the manual attached inside the side cover. 

 

Step 1. Station Number Switch setting 

Station Number Switch Settings Settings Remarks 

Station NO.  (x10) 0  
Station No.: 1  

Station NO.  (x 1) 1 

 

Step 2. Set the serial communication parameters as follows through the switch on the right side of the computer link module. 

① Transmission Speed Switch (SW1) setting 

Transmission Speed Switch Settings Settings Remarks 

Baudrate 7  19200 bps  

 

② Data Format Switch (SW2) setting 

Data Format Switch Contents Off ON Settings Remarks 

SW1 Character Length 7 bits 8 bits On  

SW2 
Parity 

None Yes Off  

SW3 Odd Even Off  

SW4 Stop bit 1 bit 2 bits Off  

SW5 Checksum None Yes On Fixed 

SW6 Ending Character None Yes On Fixed 

SW7 Protection feature None Yes Off Fixed 

SW8 User setting not allowed     

 

Step 3. After completing the setting, reset the power. 

 

 

※ Precautions for 1:N network configuration 

When configuring 1:N network, only the card of the terminating station sets the Terminator Switch. If it is not the card of the 

terminating station, set it to “OFF”. 

“4-WIRE” for RS-422 configuration / “2-WIRE” for RS-485 configuration 
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5. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagram described in this chapter may differ from the recommendations of “YOKOGAWA Electric Corporation”.) 
 

5.1. Cable table 1 
 

■ RS-232C (1:1 connection) 

 

 

– Use “KM11–2T, KM11–3T, KM11–4T dedicated cable” sold by “YOKOGAWA Electric Corporation”. 

The wiring of the dedicated cable is as the reference picture below. 
 

– When changing the connector according to the TOP model, use the D-Sub “2, 3, 5” pins of “KM11–

2T, KM11–3T, KM11–4T dedicated cable” directly. 
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5.2. Cable table 2 
 

■ RS-232C (1:1 connection) 

COM1 / COM2 

Cable connection 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 CD 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RD 2 2 RD 

SD 3 3 SD 

DTR 4 4 DTR 

SG 5 5 SG 

DSR 6 6 DSR 

RTS 7 7 RTS 

CTS 8 8 CTS 

 9 9 FG 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.  
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5.3 Cable table 3 
 

■ RS-422 (1:1 connection) 

COM1 / COM2 

Cable connection 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
Pin arrangement 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  SDB(+) 

 

 2 SDA(–) 

 3 RDB(+) 

RDB 4 RDA(–) 

SG 5 SG 

SDA 6  

 7 

 8 

SDB 9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-485 (1:1 connection) 

COM1 / COM2 

Cable connection 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
Pin arrangement 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  SDB(+) 

 

 2 SDA(–) 

 3 RDB(+) 

RDB 4 RDA(–) 

SG 5 SG 

SDA 6  

 7 

 8 

SDB 9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

■ RS-485 (1:1 connection) 

COM3 

Cable connection 

External device 

Pin arrangement*Note 1) 
Signal 

name 

Signal 

name 
Pin arrangement 

 

+  SDB(+) 

 

- SDA(–) 

SG RDB(+) 

 RDA(–) 

 SG 
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■ RS-422 1 : N connection - Refer to 1:1 connection to connect in the following method. 

TOP Cable connection and signal 

direction 

External device Cable connection and signal 

direction 

External device 

Signal name Signal name Signal name 

RDA 

 

SDB(+)  SDB(+) 

RDB SDA(–) SDA(–) 

SDA RDB(+) RDB(+) 

SDB RDA(–) RDA(–) 

SG SG SG 

 

■ RS-485 1 : N connection - Refer to 1:1 connection to connect in the following method. 

TOP Cable connection and signal 

direction 

External device Cable connection and signal 

direction 

External device 

Signal name Signal name Signal name 

RDA  SDB(+)  SDB(+) 

RDB SDA(–) SDA(–) 

SDA RDB(+) RDB(+) 

SDB RDA(–) RDA(–) 

SG SG SG 
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6. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use. 
 

 

"TOP Design Studio" represents the CPU's "Device" in accordance with the "FA–M3 Series" Multi–CPU 

configuration (on Single Unit) as "CPU Number" + "Device Name" (one unit device).  

 (Example) for Data Register 

Multi–CPU TOP Design Studio Device Name Shown 

CPU 1 Data Register 1D 

CPU 2 Data Register 2D 

CPU 3 Data Register 3D 

CPU 4 Data Register 4D 

(Note) Multi–CPU configurations can extend to up to four CPUs. 
 

 

Device Bit Address Word Address 32 Bit Remarks 

Input Relay 
1X00201 – 4X71664 1X00201 – 4X71649 

L/H 

*Note 1) 

Note 2) 

Output Relay 1Y00201 – 4Y71664 1Y00201 – 4Y71649 *Note 1) 

Internal Relay 1I00001 – 4I65535 1I00001 – 4I65535  

Joint Relay 
1E0001 – 4E4096 1E0001 – 4E4081  

Special Relay 
1M0001 – 4M9984 1M0001 – 4M9969  

Link Relay 
1L00001 – 4L78192 1L00001 – 4L78177 *Note 3) 

Timer Contact 1T0001 – 4T3072 ––––––  

 Current –––––– 1TP0001 – 4TP3072  

 Setup –––––– 1TS0001 – 4TS3072  

Counter Contact 1C0001 – 4C3072 ––––––  

 Current –––––– 1CP0001 – 4CP3072  

 Setup –––––– 1CS0001 – 4CS3072  

Data Register 
1D0001.00 – 4D65535.15 1D0001 – 4D65535  

File Register 
1B00001.00 – 4B262144.15 1B00001 – 4B262144  

Joint Register 
1R0001.00 – 4R4096.15 1R0001 – 4R4096  

Special Register 
1Z001.00 – 4Z1024.15 1Z001 – 4Z1024  

Link Register 
1W00001.00 – 4W78192.15 1W00001 – 4W78192 *Note 3) 

*Note 1)Instructions for showing Input/Output Relay are as follows.. 

(Example)      X 0[Module Unit No.] 02[Module Slot No.] 01[Terminal No.] 

Items Setting range 

Module Unit No. 0 – 7 

Module Slot No. Module unit No is “0” 02 – 16 

 Module unit No is “1–7” 01 – 16 

Terminal No. 01 – 64 

*Note 2)Read-only Device 

*Note 3) Instructions for showing link relay (L), link register (W) are as follows. 

(Example)      L 7[link Number] 1024[address] 

Items Setting range 

Link Number 0 – 7 

address 0001 – 71009 

 


